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CHAPTER 8
WINDOWS EXPLORER

Multiple Choice Questions And Answers

1. All information in computers is stored as _________
a) data b) programs c) files d) applications

2. Every file name has two components: the _________ and the ___________
a) Main Component, Extension b) Component, Extension
c) Prime Component, Extension d) Major Component, Extension

3. The _________ separates the main component from the extension.
a) comma b) dot c) @ symbol d) *

4. The file name, including the extension, can be a maximum of _____ characters long
a) 254 b) 251 c) 250 d) 255

5. The main component of files used on DOS-based computers can have a maximum of ____
characters.
a) 255 b) 9 c) 8 d) 12

6. The extension should not exceed more than three characters in DOS.
a) 10 b) 3 c) 8 d) 255

7. ______ is collection of files.
a) Folder b) program c) data d) Information

8. _________is a program that helps you to manage your files and folders
a) data b) directory c) storing d) Windows Explorer

9. You can also start Windows Explorer by right clicking on the _________button.
a) System b) Windows c) Start d) File

10. You can also start Windows Explorer by right clicking on the Start button then selecting
_____ from the short menu
a) Search b) Explore c) Windows d) Computer

11. The _______ window is selfless.
a) Search b) Explore c) Windows d) Computer

12. Windows Explorer shows the name of the current folder whose contents are visible in the
_____pane
a) Left b) Middle c) Right d) either a or b

13. Below the toolbar is the ______ area.
a) working b) task c) File d) display

14. The left pane displays either the __________ or the ________ Bar
a) Explorer b) Folder c) either a or b d) both a and b
a) data b) programs c) files d) applications

15. ______ pane in Windows Explorer displays a list of folders.
a) Left b) Middle c) Right d) either a or b

16. A small yellow icon in Windows represents each ________
a) file b) drive c) folder d) application

17. A ______ sign to the left of the folder icon in Folder Bar indicates the presence of
subfolders within this folder
a) minus b) star c) dot d) plus

18. You can see + or – sign only in the _____ Bar.
a) Task b) Folder c) Tool d) Status
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19. ________ in this part of the window allow you to browse through the list of folders.
a) Menu bars b) Task bars c) Scroll bars d) Tool bars

20. Explorer bar is divided into ______categories
a) two b) three c) four d) five

21. The display in the Explorer Bar is ________ sensitive.
a) context b) case c) task d) non

22. You can also navigate to any folder by means of the ______ bar
a) Tool b) Title c) Address d) Menu

23. The __________ View works well in folders that contain pictures.
a) Icon b) List c) Large d) Thumbnails

24. _____________view is available only in folders that contain pictures
a) Icon b) Filmstrip c) Large d) Thumbnails

25. _______view retains the small icons but displays the files and folders one below the other in
columns.
a) Icon b) Filmstrip c) List d) Thumbnails

26. __________view displays details like file size, type, last modified date and time along with
file names and small icons
a) Details b) Filmstrip c) List d) Thumbnails

27. To create a new folder, select ___________ from the menu bar
a) EditFolderNew b) FileNewFolder
c) FileFolderNew d) EditNewFolder

28. The _________ command allows you to search for files or folders.
a) search b) view c) Replace d) Address

29. If the files or folders to be selected are not displayed consecutively, hold______ key to
select multiple files
a) Alt b) Ctrl+A c) Ctrl d) Shift

30. If the files or folders to be selected appear consecutively on the screen, hold______ key to
select multiple files
a) Alt b) Ctrl+A c) Ctrl d) Shift

31. The Windows Explorer copies or moves files using the Windows XP _______
a) Copy b) Clipart c) Clipboard d) Folder

32. _________ is a temporary storage area where files or folders are stored before being copied
to the new location.
a) Clipbook b) Clipart c) Clipboard d) Folder

33. Click _______ button adjacent to Make New Folder button to store the selected items in the
newly created folder
a) Cut b) Move c) Copy d) Paste

34. You can even create a new folder by clicking Make New Folder button found at the bottom
of the _________list box
a) Move Items b) Move c) New d) Move New Items

35. When you want to copy files or folders to a disk in A or B drive, you can use the ____option
in the pop up menu
a) Send b) Copy c) Copy To d) Send To

36. If you want to Copy the selected items, you click on Copy the selected items, you will be
provided ________drop down list box
a) Copy b) Move c) Copy Items d) Move Items

37. The clipboard can hold only _____ set(s) of items at a time.
a) two b) one c) three d) four
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38. If you need to store the items placed in the clipboard permanently, make use of _____
a) ClipBook b) ClipArt c) Folder d) ClipBoard

39. For using ClipBook, click ____.
a) File → Run b) Start → Run c) Edit → Run d) View → Run

40. Coping files to a CD is often referred to as ______ the CD
a) Pasting b) Selecting c) Moving d) Burning

41. _____ and ______are the two types of CD burners.
a) CD-R, CD-RW b) CD-R, CD-W c) CD-R, CD d) CD-R, CD-WR

42. ______burner is used to burn data to blank CD-R disk.
a) CD b) CD-R c) CD-W d) CD-RW

43. _______ burner is used to burn data to either a blank CD-R or CD-RW disk
a) CD b) CD-R c) CD-W d) CD-RW

44. The _____ disk can be used as an ordinary floppy.
a) CD b) CD-R c) CD-W d) CD-RW

45. _____can be written only once.
a) CD b) CD-R c) CD-W d) CD-RW

46. In the first page of CD writing wizard, you can enter a ________for CD
a) new name b) data c) text d) label

47. To rename a file or folder, right click on the file or folder. Select _____from the shortcut list
a) New Name b) name c) New d) Rename

48. To rename a file or folder, click ______ from the menu bar.
a) FileName b) FileRename c) EditRename d) FileNewRename

49. Windows Explorer uses a special folder called the _______to hold deleted files
a) Archive b) Garbage c) Recycle Bin d) Delete

50. If you do not want to send the deleted items to the Recycle Bin, Press ________ key
combinations.

a) Alt + Delete b) Ctrl + Delete c) Shift + Delete d) Alt+Shift + Delete
51. To empty the Recycle Bin, click on the File menu and choose __________

a) Delete b) Empty c) Clear d) Empty Recycle Bin
52. If you want to restore some item, you select them and then click ________

a) Store b) Restore c) Send d) Back up
53. Windows XP allows you to create________ kinds of shortcuts.

a) two b) one c) three d) four
54. You can create a keyboard shortcut for any program by using the ____ dialog box of that

application.
a) Files b) Properties c) Folder d) Shortcut

55. The small arrow to the left of the icon indicates that the icon is a ________
a) Icon b) Picture c) folder d) Shortcut
To open a Search window, click _________
a) ViewExplorer BarSearch b) FileExplorer BarSearch
c) View Search d) ViewSearchExplorer Bar

56. To open a Search window, click _________
a) FileSearch b) StartSearch c) ViewSearch d) SearchStart
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57. The ________command on the Start menu offers an alternate method to start applications or
open data files.
a) Window b) Shortcut c) Run d) Open

58. The Search command is also available on the _______toolbar.
a) two b) one c) three d) four

59. The _______ command is most often used to install new software or games from a CD or a
floppy disk.
a) Window b) Shortcut c) Run d) Copy

60. ______is the location of the file.
a) Open b) Address c) Name d) Path

61. Path names always start with the ______ followed by folder names and end with the file
name.
a) directory b) drive c) disk d) Program

62. The drive, folder names and file name are all separated by_______.
a) *(asterisk) b) /(slash) c) \ (backslash) d) , (comma)

63. To use the Run command, click on the _______ button and select ______
a) Run, Open b)Start, Run c) Run, Start d) Open, Run

64. The inverted triangle in the Open box displays a list of recently used ______names.
a) path b) file c) folder d) file type

65. The _______button lets you search for a file or folder.
a) Path b) Find c) Search d) Browse

66. Windows XP lets _______users Log on at the same time.
a) two b) multiple c) three d) remote

67. By default, Windows XP Professional _______the Taskbar.
a) unlocks b) enables c) locks d) disables

68. The status area (system tray) is known as ________area.
a) display b) task c) view d) notification

69. If you insert a CD and if it starts playing the music immediately, this facility is called _____.
a) Play b) Autoplay c) Burn d) Run

70. ______is normally situated between Ctrl and Alt keys.
a) Win key b) Shift key c) Esc key d) space bar

71. _______ Winkey combination is used to display the Desktop.
a) Winkey+E b) Winkey+D c) Winkey+F d) Winkey+A

72. _______ Winkey combination is used to Opens an Explorer window showing My Computer.
a) Winkey+E b) Winkey+D c) Winkey+F d) Winkey+A

73. _______ Winkey combination is used to Opens a Search Results window and activates
Search Companion.
a) Winkey+E b) Winkey+D c) Winkey+F d) Winkey+A

74. _______ Winkey combination is used to moves the focus to the notification area.
a) Winkey+E b) Winkey+B c) Winkey+F d) Winkey+D

75. _______ Winkey combination is used to Opens a Help and Support Center window.
a) Winkey+E b) Winkey+D c) Winkey+F d) Winkey+F1

76. _______ key toggles the display of the Start menu.
a) Winkey+C b) Winkey c) Winkey+F d) Winkey+D

77. _______ Winkey combination is used to displays Utility Manager.
a) Winkey+E b) Winkey+B c) Winkey+U d) Winkey+D
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78. _______ Winkey combination is used to displays the Run dialog box.
a) Winkey+F1 b) Winkey+D c) Winkey+F d) Winkey+R

79. _______ Winkey combination issues a Minimize All Windows command.
a) Winkey+E b) Winkey+M c) Winkey+F d) Winkey+D

80. Windows XP Professional includes a_______utility and an _______feature that can be
activated from boot up to restore a damaged system.
a) ASR b) Backup c) Save d) both a and b

81. ASR stands for ________
a) Automated System Recovery b) Auto System Recovery
c) Automated Software Recovery d) Automated System Run

82. ______files allows you to store copies of files located on network drives on your local drive.
a) data b) system c) backup d) Offline

83. _______Desktop allows you to access the Desktop of the computer connected remotely
a) Dual b) Remote c) Windows d) User

84. You can use _________to rollback the changes to an earlier point at which the system was
working properly..
a) Backup b) Rollback c) Restore d) System Restore

85. __________is a mischievous program designed to damage the Software, Hardware and / or
data.
a) Bacteria b) Worm c) virus d) Computer virus

86. Viruses come in _______ basic flavours.
a) two b) one c) three d) four

87. _______ Viruses attach themselves to executable files and spread among other files when
you run the program.
a) Trojan horse b) worms c) Boot sector d) File infectors

88. ______appear to be legitimate programs at first glance but when loaded, proceed to viciously
damage your data
a) Trojan horse b) worms c) Boot sector d) File infectors

89. _________is a program to safeguard your system from the virus programs.
a) Trojan horse b) worms c) Boot sector d) Antivirus

90. Now-a-days, ________is the major source of producing viruses.
a) Mobile b) Internet c) Software d) Computer

91. ______key combination is used to display the properties sheet for the selected objects
a) Alt + Enter b) Alt + F4 c) Alt + F3 d) Ctrl + F4

92. ______key combination is used to close the active window
a) Alt + Enter b) Ctrl + F4 c) Alt + F4 d) Alt + F2

93. ______key combination is used to selects all the objects in the current folder
a) Ctrl + C b) Ctrl + A c) Ctrl + V d) Ctrl + X

94. ______key combination is used to Reverses the most recent action.
a) Ctrl + X b) Ctrl + A c) Ctrl + V d) Ctrl + Z

95. ______key is used to Displays the Find dialog box with the current folder as the default.
a) F3 b) F4 c) F1 d) F2

96. ______key is used to Opens the Address toolbar’s drop-down list.
a) F3 b) F4 c) F1 d) F2

97. ______key is used to Refreshes the Explorer window.
a) F3 b) F4 c) F5 d) F2
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98. ______key helps to rename the selected object.
a) F3 b) F4 c) F1 d) F2

99. ________Displays the context menu for the selected objects
a) Ctrl+ F10 b) Shift+F10 c) Ctrl+F4 d) Shift+F4

100. ____Cycles the highlight among the All Folders list, the contents list, and the address toolbar
a) Tab b) F6 c) F4 d) either a or b

***********

TWO MARKS QUESTIONS AND ANSWERS

1. Write a short note on file names.
All information in computers is stored in Files. Every file has a unique name that helps us to
identify it. A file name is made up of two components:

1. Main Component
2. Extension

2. What are files and folders ?
i) All information on disks are stored as files.
ii) A collection of related files or subfolders is called a folder.

3. What is Window Explorer? How to open it?
i) Windows Explorer is a program that helps us to manage our files and folders. To start Windows

Explorer, click on StartAll ProgramsAccessoriesWindows Explorer.

ii) We can also start Windows Explorer by right clicking on the Start button and then selecting
Explore from the short cut menu.

4. What are the three categories of Explorer bar?
Explorer bar is divided into three categories. They are:

1)  File and Folder Task
2)  Other Places
3)  Details

5. What is the difference between copying and moving files?

6. What are the three different ways for moving and copying files and folders?
1)  Click on the Edit menu and make appropriate choice.

2) Right click on any one of the selected folders or files, in the short cut menu and make
suitable selection.

3)  You can use the keyboard combinations Ctrl+X (Ctrl+x) to cut, Ctrl+C (Ctrl+c) to
copy and Ctrl+V (Ctrl+v) to paste.

Copying files Moving files
Copying leaves the source files or folders
untouched and makes a copy in the destination
location.

Moving removes the files or folders from the
source location and places them in the
destination location.
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7. Distinguish between CD-RW and CD-R.

CD –R CD- RW

CD-R could be written only once. The CD- RW disk could be written and used
as an ordinary floppy.

CD-R is used to burn data to blank CD-R
disk.

The CD- RW burner is used to burn data to
either a blank CD-R or CD-RW disk.

We can only add files to CD-R We can add and delete files from CD-R

8. What is CD burning?
Coping files to a CD is often referred to as burning the CD, because a laser actually burns the
information on to the disk.

9. How will you Rename a group of Files?
 If we want to rename a group of files or folders, there is no special help from Explorer Bar.
 We can use right click method or from the menu bar method.
 Example: If we have chosen the name “rajan” to rename the group of files or folder, the item

that gets focus is named as rajan, the other file are named as rajan (1), rajan (2) and rajan (3).

10. What are the two kinds of short cuts created by Windows XP?
Windows XP allows you to create two kinds of shortcuts.

i)  Keyboard shortcuts
ii)  Desktop shortcuts
.

11. How do you open the Run command?
 Click on the Start button and select Run.
 Type the file name in the Open box.
 The inverted triangle in the Open box displays a list of recently used pathnames.
 The Browse button lets you search for a file or folder.

**********
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THREE MARKS QUESTIONS AND ANSWERS

1. Write short notes on the components of File name.
A file name is made up of two components:

i)  Main Component
ii)  Extension

i)  Main Component:
 The first part of the file name is the main component.
 It is also called as primary name.
 This is the name given to the file by the user.
 The dot (or full stop) separates the main component from the extension.
 The main component can contain alphabets, numbers, spaces and other characters like @, $, !,

{, (, ), [, ] .
 It does not contain. \, /,* , ?, “, <, >.
 Comma and full stop are also not included

ii)  Extension:
 Extension is the second part of the file name.
 It is also called as secondary name.
 The extension is used to identify the type of the file
 It is normally up to three to four characters long.
 Some examples of file extensions are .DOC, .BAS, .XLS and .java.

2. Write short notes on folders in Windows Explorer.
 A folder is a collection of related files or subfolders.
 A small yellow icon represents each folder.
 The disk drives on the computer are also treated as folders.
 We can see + or – sign only in the Folder Bar.
 A plus sign to the left of the folder icon in Folder Bar indicates the presence of subfolders

within this folder.
 We can click on the plus sign to display a list of the subfolders.
 When you do this, the plus sign changes to a minus sign.
 Clicking on the minus sign will hide the details.

3. How do you select files in Windows Explorer?
Selecting one file or folder: Click on the file or folder and it gets highlighted.

Selecting multiple files or folders:
i) If the files or folders to be selected appear consecutively on the screen, click on the first file

or folder.
ii) Using the scroll bars point the mouse pointer to the last file or folder in the list, hold the Shift

key down and click.
iii) If the files or folders to be selected are not displayed consecutively, then, click on the first

file, move the mouse pointer to the second file to be selected while holding the Ctrl key
down.

iv) Repeat the procedure for each of the other files to be selected.
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4. How do you create a new folder?
i) To create a folder, simply click Make a New Folder under File and Folder Task in the

Explorer Bar.
ii) Right click anywhere in the empty space in the right pane of the Explorer window. Click on

New from the menu shortcut.
iii) To create a folder from Menu bar,  Click FileNewFolder.

A new folder with the temporary name “New Folder” is created. Simply type the name you want to
give this new folder and press ENTER.

5. What is the Run command used for?
 The Run command on the Start menu offers an alternate method to start applications or open

data files.
 When we use the Run command to open a data file, it automatically starts the corresponding

application.
 The Run command is most often used to install new software or games from a CD or a floppy

disk.
 We should enter the complete file name along with the Path.
 Path is the location of the file.
 Path names always start with the drive followed by folder names and end with the file name.
 The drive, folder names and file name are all separated by \ (backslash).
 Example: c:\All Programs\Microsoft Office\WinWord

6. How do you create Keyboard Shortcut?
 We can create a keyboard shortcut for any program by using the Properties dialog box of that

application.
 Right click on the application, select Properties.
 The Properties dialog box opens on the screen. Click the Shortcut tab.
 In shortcut key text box type a letter of your choice and click on OK.
 The box will display Ctrl + Alt + “the key you selected”,
 We cannot use ESC, ENTER, TAB, SPACEBAR, PRINT SCREEN, SHIFT or BACKSPACE

keys

7. How do you create a Desktop Short cut?
 First locate the application using Windows Explorer
 Right click on the application file and select Create Shortcut from the menu.
 A new file called Shortcut to . . . . is created.
 Restore the Explorer window so that you can see a part of the desktop.
 Drag and drop the shortcut file.
 Now the desktop will have the Shortcut for that application

8. How will you Rename a File or Folder?
1) Click the file or folder.  When you are in Explorer Bar, choose Rename this folder from File

and Folder Tasks. The name of the selected file  gets highlighted.  Now, type the new name
and press Enter.

2) To rename a file or folder, right click on the file or folder. Select Rename from the   shortcut
list. Now change the name

3) From the menu bar, click File Rename and rename the file.
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9. What is a virus? What are the  three basic types?
Computer virus is a mischievous program designed to damage the Software, Hardware and /  or data.
Viruses come in three basic types:

i) File infectors:
- File infectors attach themselves to executable files and spread among

other files when you run the program.

ii) Boot sector viruses:
- Boot sector viruses replace the hard disk’s master boot record

iii) Trojan horse viruses
- Trojan horse viruses appear to be legitimate programs at first glance

but when loaded, proceed to viciously damage your data.

**************

FIVE MARKS QUESTIONS AND ANSWERS

1. Describe the different parts of the Windows Explorer window.

 Windows Explorer is a program that helps you to manage your files and folders.
 To start Windows Explorer, click on StartAll ProgramsAccessoriesWindows

Explorer
 We also start Windows Explorer by right clicking on the Start button and then selecting

Explore from the short cut menu.
 Explorer window also contains a title bar, a menu bar and a toolbar.
 The title bar shows the name of the current folder whose contents are visible in the right pane

(Main Pane).
 Below the toolbar is the display area.
 Display area is divided into two panes.

i) The left pane displays either the Explorer Bar or the Folder Bar
ii) The right pane always displays the contents of the currently selected folder in

the left pane.

**********

2. Describe briefly the different ways in which you can view information in Windows Explorer.

i) The Icons View: The Icons View shows each file or folder’s icon and its name.

ii) The Tiles View: In this view, the icons are a little bigger. In addition to icon and its name,
this view provides some more additional information for some icons.

iii) The Thumbnails View : The Thumbnails View works well in folders that contain pictures.

iv) The Filmstrip View : This view is available only in folders that contain pictures such as
My Pictures Folder.
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v) Thumbnails View : When you click or point to a picture, an enlarged copy of the picture
appears in preview area.

vi) List View : This view retains the small icons but displays the files and folders one below
the other in columns.

vii) Details : This view displays details like file size, type, last modified date and time along
with file names and small icons.

***********

3. Describe the different methods to copy the selected files.

Copy the files from one folder to another:
 Right click on any one of the selected files, and click Copy
 Open the destination folder,  right click and select Paste
 We can use the keyboard combinations Ctrl+C to copy and Ctrl+V to paste.

Copy files to Floppy:
 First select the file and then, right-click on the selected files.
 Click on Send To and 3 ½ Floppy [A]
 Click on 3 ½ Floppy [A] in the left pane to check that the files have been copied.

Copy the files by using the Explorer Bar:
 Click the Folders in the toolbar. Explorer Bar will be shown.
 To Copy the selected items, click on Copy the selected items
 From the Copy Items drop down list, browse and select the desired destination
 Click Copy button adjacent to Make New Folder button to storethe selected items in the

newly created folder

Copy the files with Edit menu:
 Select the files and Click on the menu Edit Copy.
 Move to the destination and  Click on the menu Edit Paste

**********
4. Explain the different ways in which the selected files are moved.

Move the files from one folder to another:
 Select the files using mouse or keyboard shortcut
 Right click on any one of the selected files, and click Cut
 Open the destination folder,  right click and select Paste

We can use the keyboard combinations Ctrl+X to cut and Ctrl+V to paste

Move files and folders with Explorer Bar:
 Click the Folder in the toolbar.
 Explorer Bar will be shown with the following options under File and Folder Tasks

i) Move the selected items
ii) Copy the selected items
iii) Publish the selected items on the Web
iv) E-mail the selected items
v) Delete the selected items

 Click on Move the selected items.
 In the Move Items list box, browse and select the desired destination
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 To create a new folder, click Make New Folder button found at the bottom of the Move Items
list box.

 Click Move button adjacent to Make New Folder button to store the selected items in the
newly created folder.

*************

5. How will you Copy files to CD?
Coping files to a CD is referred to as burning the CD. There are two types of CD burners:

i) CD-R burner - used to burn data to blank CD-R disk
ii) CD-RW burner - used to burn data to either a blank CD-R or CD-RW disk.

Method for Copying to CD:
 Insert a suitable blank CD into the suitable drive and wait for a few seconds.
 In the ensuing dialog box click, open writable CD folder using Windows Explorer and click

OK.
Here CD-RW Drive is used.

1. If dialog box does not appear on the screen within a few seconds of inserting the blank disk,
open your My Computer folder. Then right –click the drive’s icon and choose Open

2. Go to the source folders.
3. Select items you want to copy to the CD. Right click any selected item and choose Send to

a CD –RW Drive.

4. Each item to be copied will appear as a temporary file, with black arrows pointing
downwards

5. Click write these files to the CD under CD Writing Tasks in the Explorer bar of  the
CD’s folder Window.

6. In the first page of CD writing wizard, you can enter a new name for CD.
7. Wait until the wizard burns the data to the CD. Then click Finish button

***********

6. Write short notes on Search.
 The Search facility of Windows XP allows you to find the lost file in the computer.
 If you search for a document, you should provide a word or phrase that appears in the

document.
 click StartSearch or click ViewExplorer Bar Search (or click search button in the

Explorer windows toolbar).
 In the right pane we can see To start your search, follow the instructions in the left pane.
 The left pane of the Explorer windows we can see what do you want to search for?

i) The first choice is Pictures, Music, or video.
ii) The second choice is Documents (Word processing, spread sheet, etc.)
iii) The next choice is All files and folders

 To search a file or folder, we can use the wild card entries such as ?,*.
 The ? Stands for a single letter and * stands for zero or more letters.
 Enter file name or part of a file name, click Search.
 Click Back button to repeat the Search.

**************
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7. Explain the Recycle Bin. How is it used?
Windows Explorer uses a special folder called the Recycle Bin to hold deleted files. The Recycle Bin
folder is available on the Desktop and can be used like any other folder. Double-click on the icon to
open it and check if the deleted files are present.

i) Deleting files and folders:
 To delete files, first select them.
 Then right click on the files and the shortcut menu appears.
 Select Delete from the shortcut menu and the files will get deleted. (They moved to

Recycle Bin). You can drag the selected file / files to the Recycle Bin or to its Explorer
Windows.

 When you are in Explorer Bar, you can delete selected files by just clicking Delete the
selected items from File and Folder Tasks

 If you do not want to send the deleted items to the Recycle Bin, Press Shift + Delete key
combination

ii) To empty the Recycle Bin:
 Click on the File menu and choose Empty Recycle Bin.
 If you double click the Recycle Bin, it will open in the Explorer Bar. Contents of the Recycle

Bin are shown in the right pane.
 Under the Recycle Bin Tasks you are shown two alternatives. (a) If you want to restore some

item, you select them. Then click the Restore, all the selected items are sent to their former
destinations.

 If you click Empty Recycle Bin, all the items will be eliminated from your computer’s
storage.

8. How do you delete Files and Folders from CD-RW disk?

1) Insert CD-RW disk into your CD-RW drive. Then one of the three possibilities will happen.

i)     The Windows XP Professional may provide you with a dialogue box asking you
what you want to do. Choose open folder to view files using Windows Explorer.
Go to step 2.

ii)    A program opens and starts playing the CD, close the program and then choose
open folder to view files using Windows Explorer. Go to step 2.

iii)    If nothing happens, open your My Computer folder, right-click the icon for the
CD-RW drive and choose open folder to view files using Windows Explorer.
Go to  step 2.

2)  In the Ensuing Explorer Window, click Erase

**********
9. What are the special features available in Windows XP Professional?

1) Easier Installation and Updating
2) Effective Multi-user Capabilities
3) Redesigned Start menu
4) Taskbar Changes and Enhancements
5) Notification area
6) Better Audio and Video Features
7) CD Burning
8) Search Companion
9) Enhanced Autoplay Feature
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10) More Games
11) Remote Desktop Connection
12) A more Useful Winkey
13) Improvement for portable computers
14) More Help
15) Network Connectivity
16) Multiple Monitor Support-For Both Desktop and Laptop.
17) Backup and Automated System Recovery (ASR)
18) Offline Files
19) Remote Desktop
20) Protected Memory Management
21) System File Protection
22) System Restore
23) Device Driver Rollback
24) Compatibility with Windows 9x Applications
25) Guarding Against Viruses

**********

10. List the Winkey combinations used in Windows XP.

Winkey
Combination What it does

Winkey Toggles the display of the Start menu

Winkey+B Moves the focus to the notification area

Winkey+Break Displays the System Properties dialog box

Winkey+D Displays the Desktop

Winkey+E Opens an Explorer window showing My Computer

Winkey+F Opens a Search Results window and activates Search
Companion

Winkey+Ctrl+F Opens a Search Results window, activates Search
Companion, and starts a Search for Computer

Winkey+F1 Opens a Help and Support Center window

Winkey+L Locks the computer

Winkey+M Issues a Minimize All Windows command

Winkey+Shift+M Issues an Undo Minimize All command

Winkey+R Displays the Run dialog box

Winkey+Tab Moves the focus to the next button in the Taskbar

Winkey+Shift+Tab Moves the focus to the previous button in the Taskbar

Winkey+U Displays Utility Manager
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